
Welcome to the Apple Internet Server Solution for the World Wide Web. On
the accompanying CD-ROM disc, you’ll find a collection of software that lets
you establish a Web site on the Internet quickly and easily. Using the
programs provided, you can create a Web site that includes pages with
hypertext links, clickable maps, pictures, interactive forms, and database
integration. You can then make your Web site available to users on the
Internet or on your organization’s internal network (intranet). You can also
provide domain name services for your network using MacDNS.

This booklet describes the procedures for setting up and starting to use the
software. These include

m installing the software from the Apple Internet Server Solution CD-ROM disc

m connecting your server to a TCP/IP network or the Internet

m configuring your TCP/IP connection

The software installation process creates a local Web site on your server. Be
sure to read the documents on this local site; they offer tips and suggestions
for using the Apple Internet Server Solution (AISS) software to set up and
maintain your own Web site. If you haven’t already done so, you should also
review the printed manuals that came with your server hardware.
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About Web servers

When you browse the World Wide Web using an application like Netscape
Navigator™, you view screens, called pages, that present information in a
graphical, easy-to-read format. A collection of Web pages organized around a
particular topic and linked with one another through hypertext links is called
a site. A Web site is identified by an address, called a URL (an acronym for
uniform resource locator). Sites can be “owned” by individuals, companies,
institutions, or governments, among others. For example, you can visit a Web
site maintained by Apple Computer by choosing Open Location from the File
menu in Netscape Navigator and entering the URL http://www.apple.com.

When people visit a particular Web site, they are in effect connecting to the
computer where the Web pages for that site are stored. The computer runs a
Web server application, such as WebSTAR, that “serves” the Web pages to
people who visit the site. Depending on how you set up your Web server, you
can make your site accessible to people on the Internet or to people on your
company or school network only. This latter configuration, called an intranet,
allows you to create a Web site that is only accessible to users on a specific
local area or wide area network. For example, if you want to provide
confidential information for employees of your company, you can create a
Web site on a server located on your local area network (LAN).
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Contents of the Apple Internet Server Solution CD

Software

The Apple Internet Server Solution CD includes applications with which you
can set up a Web server and additional programs that extend the functions of
your server. The applications, arranged by function, include these:

Administration tools
m LogDoor provides real-time management for a server’s log file.

m MacTCP Watcher reports details of TCP connections and activity.

m PageSentry monitors and tests several types of servers, reports failures,
and restarts servers that are down.

Browsers and viewers
m Adobe™ Acrobat™ Reader lets you read and print Portable Document

Format (PDF) documents, regardless of the application or type of computer
that created those documents.

m Netscape Navigator lets you browse Web pages on your server and on the
Internet. It also gives you the opportunity to preview your pages as you’re
creating them.

Database tools
m Butler SQL Server provides relational database management for multiple

users and a variety of application programs.

m Tango Enterprise provides tools to integrate database content into Web
applications.

HTML editors
m BBEdit is a versatile text editor that lets you work directly with HTML

files and manage a Web site.

m Claris Home Page gives you an easy way to create Web pages without
having to be familiar with HTML (Hypertext Markup Language)—the
standard language for Web pages.

m GoLive CyberStudio lets you create Web pages in a graphical environment
and offers drag-and-drop image placement and table editing.
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Server software
m FireSite™ accelerates Web site operation by moving large files to the

service provider’s site and using the provider’s fast connection to serve
those files. The program also lets one server contain multiple domain
names.

m MacDNS lets you assign domain names, IP addresses, aliases, and mail
exchange information for a server.

m NetCloak allows you to control numerous elements on your Web pages and
configure the content delivered according to the user, password, domain
name, and many other variables.

m Rumpus (FTP Server) provides the software to set up an FTP server,
which is used for file transfers and efficient access to archived files.

m WebSTAR is a Mac OS–based Web server system that provides the
software necessary to serve your Web site on the Internet or on an intranet.

See the Appendix of this booklet for the manufacturers’ names and Web
addresses, along with a more detailed description of each application.

Software keys

Some applications on the AISS CD require that you type a set of numerals
and letters, known as a key or serial number, the first time you use the
program. See the Read Me file on the CD for specific information about the
keys you need for AISS software.

Software support

The software on the AISS CD comes from several different companies,
including Apple. The developer of each application supports that application.

IMPORTANT If you have a problem with an application on the AISS CD,
contact the company that manufactures that application. See the document
named “ProductSupport.html” in the HTMLpages folder (in the
Documentation and HTML folders) for contact information.
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Documentation

Documentation for each application in the Apple Internet Server Solution is
provided in electronic form, as a PDF (portable document format) file that
you read, print, and search with Adobe Acrobat Reader, or as a set of HTML
files that you read or print with Netscape Navigator. The electronic manual
for each application is located in the Documentation folder.

AISS also has its own set of HTML documents, located in the HTML Pages
folder, which you can view and print using Netscape Navigator. These
documents provide tips and ideas for adding features such as clickable maps
and interactive forms. The HTML documents also provide technical support
information and include hypertext links to additional sources of information
about Web servers, the Internet, and related topics.

In addition, the Apple Internet Server Solution package contains the book
Planning and Managing Web Sites on the Macintosh: The Complete Guide to
WebSTAR and MacHTTP, by Jon Wiederspan and Chuck Shotton (Addison-
Wesley Developers Press, 1996). This comprehensive book details the
WebSTAR software, offers a digest of HTML tags, and provides extensive
coverage of CGI scripting. The book contains a CD with numerous shareware
and freeware applications, software demonstration versions, and examples of
server documents.

Sample Web pages

The Apple Internet Server Solution provides sample Web pages for a fictional
company called Global Networks, Ltd. These sample Web pages illustrate
what you can do with electronic art, clickable maps, interactive forms, and
hypertext links. Look at these pages for ideas or use them as templates for
your own Web pages.

IMPORTANT When you install the AISS software, the sample Web pages are
installed as your server’s default home page. Be sure that you either rewrite
the sample pages to provide information about your Web site or replace the
sample pages with Web pages that you’ve created for your site. If you don’t
rewrite or replace the sample pages, users visiting your Web server will see
the home page for the fictional company (Global Networks) instead of a
home page for your Web site.
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For more information

Books about the Internet and the Web

There are hundreds of books available about the Internet and the World Wide
Web, with dozens more coming out every month. Here are a few:

Ablan, Jerry, and Scott Yanoff. Web Site Administrator’s Survival Guide.
Sams.net Publishing, 1996.

Anthony, Tobin. Building and Maintaining an Intranet with the Macintosh.
Hayden Books, 1996.

LeVitus, Bob, and Jeff Evans. WebMaster Macintosh: How to Build Your Own
World-Wide Web Server Without Really Trying. 2nd edition. AP Professional,
1996.

Morgan, Eric Lease. Teaching a New Dog Old Tricks. A comprehensive book
about Macintosh computers and the World Wide Web. Available on the Web
at http://152.1.24.177/teaching/manuscript/.

Sachs, David, and Henry Stair. The 7 Keys to Effective Web Sites. Prentice Hall
PTR, 1997.

Taylor, Dave. Macworld Creating Cool HTML 3.2 Web Pages. IDG Books, 1996.
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Apple Web sites

Apple Computer offers several Web sites with information about the Internet
and related topics. The following table lists the URLs for some of the Apple
Web sites that you may want to visit.

Web site (URL) What it provides

http://www.info.apple.com/AISS/ The AISS site, which provides up-to-date 
information and links to developers of 
the AISS applications 

http://www.apple.com Apple’s home page

http://www.info.apple.com/ General support and product information

http://www.solutions.apple.com/ Internet facts and ideas, and general 
networking product information

http://education.apple.com News and information about Apple’s 
education products and programs

http://applenet.apple.com/hi/web/web.html Excellent advice for planning Web content of 
any size or scope

http://macos.apple.com Mac OS information and updates

http://www.solutions.apple.com/apple-internet/ Extensive group of mailing lists on the Internet 
and related subjects
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The Apple Internet Server Solution includes tools and utilities for a variety of
server functions and site-management tasks. You may not want to use all of
the software in AISS, depending on the purpose of your Web server. The
table that follows presents the amount of memory occupied by each
application to help you determine which ones to install.

Minimum Recommended
Application RAM RAM

Acrobat Reader 2.2 MB 6.4 MB

BBEdit 1.8 MB 2.2 MB

Butler SQL 4.9 MB 6.9 MB

FireSite 1.6 MB 1.6 MB

GoLive CyberStudio 10.4 MB 18.4 MB

Home Page 3.5 MB 5.8 MB

LogDoor 1.2 MB 1.4 MB

MacDNS 1.5 MB 1.5 MB

MacTCP Watcher 0.6 MB 0.6 MB

PageSentry 1.4 MB 2.2 MB

Rumpus (FTP Server) 3.3 MB 5.3 MB

Tango Enterprise 1.3 MB 1.8 MB

WebStar 1.6 MB 3.3 MB

WebStar Admin 0.6 MB 0.6 MB

Installing the Software
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Once you decide which applications you want to use, you can begin the
installation process. If you aren’t sure whether you need all the applications,
it’s a good idea to install all the AISS software. You can later remove any
applications you don’t need.

Follow these steps to install the software from the Apple Internet Server
Solution CD.

1 Insert the Apple Internet Server Solution CD in your server’s CD-ROM drive and open the
CD’s icon.

The CD’s contents look like the illustration below.
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2 Double-click the Install AISS icon and click Continue in the opening screen.

When you click Continue, the main Installer window appears.

3 Go through the first three steps on the Installer screen to prepare for installation.

Instructions on the screen tell you when each step is complete.
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4 Click the button next to “Install the Software”  at the bottom of the Installer screen to
transfer the software from the CD to the disk you designated for installation. 

You have a choice of which software to install. Apple recommends that you
install all the software.

Click the box next to each item you don’t want to install. This will 
remove the X.

5 Click Start to begin software installation. 

Messages on the screen report the progress of installation. If you’re installing
Acrobat Reader, you are asked to read and accept the software license. Click
Agree.

6 Click Restart to restart the server when software installation is complete.

After you restart your server, a dialog box appears and asks you to register
your copy of WebSTAR.

7 Register your copy of WebSTAR by entering the number located on the WebSTAR
registration card. 

The WebSTAR registration card comes in the Apple Internet Server Solution
package.

12 Apple Internet Server Solution



8 Open Netscape (if necessary) by locating and double-clicking its icon in the 
Browsers folder. 

The software may start up automatically after you register WebSTAR. If a
license agreement appears on the screen, read it and click Agree.

WebSTAR and Netscape Navigator are now running. The Apple Internet
Server Solution home page (stored locally on your server), similar to the one
shown below, appears in a Netscape Navigator window.

If you do not see the AISS home page, go to the section “Viewing the AISS
Home Page” later in this booklet for instructions.
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Your server must be connected to a network before people can visit your Web
site. In most cases, this means that you need a connection between your
server and the Internet. See the instructions in this section for details about
connecting to the Internet. If you aren’t planning on connecting your server to
the Internet and want to put your server on a company network (intranet),
skip the instructions here and go directly to the section “Configuring Your
TCP/IP Connection.”

IMPORTANT If you don’t yet have a network connection, you can still get
started with the Apple Internet Server Solution. Begin by reading the
documents in the “HTML Pages” folder. See the previous section, “Installing
the Software,” for step-by-step instructions on installing the software.

Follow these steps to set up an Internet connection:

1 Obtain an account with an Internet service provider (ISP). 

A list of some domestic and Internet access providers is included in the AISS
Web pages.

2 Choose a method of physically connecting your Web server to the Internet. 

For some people, this may be as simple as using a modem and a telephone
line. If you want your server to be accessible 24 hours a day or if you expect
many visitors (thousands) at your Web site, you may want to invest in a more
robust connection method, such as a T1 line or an ISDN connection. Consult
your Internet service provider about the methods that may best serve your
needs.

Making a Network Connection
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If your server is on a local area network (LAN), you probably need a router to
connect your network to the Internet service provider’s network. Consult your
network administrator.

3 Obtain the following TCP/IP configuration information from your ISP (or network
administrator).

You’ll use this information when you set up your TCP/IP connection,
described in the next section.

m Connection type

If your server is directly connected to a network, such as a LAN, you’ll
probably want to choose Ethernet. If you have a dial-up (modem)
connection to the Internet using SLIP (Serial Line Internet Protocol) or
PPP (Point-to-Point Protocol) software, you’ll select the SLIP or PPP
connection type. Consult your ISP for instructions.

m IP address

An IP address is a set of four numbers from 0 to 255, separated by periods
(for example, 140.140.54.2). It uniquely identifies your server on the
network. Your ISP or network administrator should provide you with an IP
address.

m Gateway address (also called a router address)

A router is a device that directs information along the most efficient or
appropriate network path. It connects two or more network cables, thereby
allowing computers and other network devices on each cable to
communicate with each other. Your ISP or network administrator should
provide you with a gateway (router) address.

Note: If you have a dial-up connection to the Internet using SLIP or PPP
software, you do not need to enter a router address.

m Domain name

For the purposes of this booklet, the domain name is the name that
identifies the Web site where your server is located. For example, if your
company is called “JNP Designs,” your domain name may be something
like “jnpdesigns.com.” Consult your ISP or network administrator for your
particular domain name.
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m IP address for a server providing domain name services

In many cases, the domain name services are provided by your ISP. If your
ISP provides domain name services, consult your ISP for the appropriate IP
address. If you plan to use MacDNS to provide your own domain name
services, use the IP address of the machine that will be running the
MacDNS software; this can be the same machine that WebSTAR is running
on or another machine on your network.

m Subnet mask

Some organizations use a subnet mask number to manage the number of IP
addresses that are available for a network. If your network uses a subnet
mask, you must enter it for your server to work correctly on the network. A
subnet mask is a set of four numbers from 0 to 255, separated by periods
(for example, 255.255.255.0).
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Once your server is connected to a network, you need to configure TCP/IP on
the server. You use the TCP/IP control panel for this purpose.

The following TCP/IP settings are appropriate for most users. Consult your
ISP or network administrator to verify that they are appropriate for your
server. For detailed descriptions of all the settings available in the TCP/IP
control panel, refer to the Workgroup Server Administrator’s Manual that came
with your server.

1 Open the TCP/IP control panel. 

You can open the control panel by choosing Control Panels from the Apple
(K) menu and choosing TCP/IP from the submenu.

2 Choose User Mode from the Edit menu and click the Administration button. Then click OK.

Configuring Your TCP/IP Connection
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3 Choose the appropriate connection type from the “Connect via” pop-up menu.

Ethernet is the most common connection type.

4 Choose Manually from the Configure pop-up menu.

5 Type your server’s IP address in the “IP Address” box.

6 If you have a subnet mask number, type it in the “Subnet mask” box.

7 If you have the IP address for a router, type it in the “Router address” box.

8 If you have the IP address of a name server, type it in the “Name server addr” box.

You can enter more than one name server address in the “Name server addr”
box. Press Return after each address. You can specify as many name servers
as you want as long as you do not type more than 255 characters.

Note: If you are using MacDNS, type the IP address of the machine running
the MacDNS software.

9 Close the TCP/IP control panel.

10 If you have made configuration changes, an alert box asks if you want to save changes.
Click Save.

If you have changed the default port, the alert box also tells you that the
change will interrupt any TCP/IP services that are established.

Your changes are saved as the default configuration and take effect immediately.

If, after configuring the TCP/IP control panel, you see an error message such
as “Unable to locate host” or “Could not create a socket,” your software is
unable to reach the network. This indicates a problem in the TCP/IP
configuration. See the administrator’s manual that came with your server for
more information, or consult your ISP or network administrator.
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When you install the Apple Internet Server Solution software, the Installer
places a file named “Welcome.html” on your server. This HTML file is the
AISS home page. When you restart your server after installation, the home
page appears in a Netscape Navigator window. Use the home page as the
jumping-off point to learn more about the AISS software and about Web
servers in general.

If the AISS home page doesn’t appear in the Netscape window when you
restart your server, you can locate and view it in one of the following ways.

If you’re not yet connected to a network

To access the home page locally on your server, follow these steps. (You do
not have to be connected to a network to use this method.)

1 Open Netscape Navigator. 

2 Choose Open File from the File menu.

3 In the dialog box, locate and open the file named “Welcome.html.”

The path is
Documentation:HTML:HTMLpages:Welcome.html. In other words, the file
is located in the “HTMLpages” folder, in the HTML folder, in the
Documentation folder on your hard disk.

The AISS home page appears in a Netscape Navigator window.

Viewing the AISS Home Page
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If you are already connected to a network

This method for viewing the home page simulates the way other people on a
network will reach your Web site. (To use this method, WebSTAR must be
running on your server.) You can use this method to test whether your Web
site is accessible to users on the network.

1 Open Netscape Navigator. 

2 Choose Open Location from the File menu.

3 In the dialog box, type

http://yourIPaddress/Documentation/HTML/HTMLpages/

welcome.html

For example, if your IP address is 17.255.34.35, you’d type

http://17.255.34.35/Documentation/HTML/HTMLpages/

welcome.html

4 Click Open or press Return. 

The AISS home page appears in the Netscape Navigator window.
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The following software is provided on the Apple Internet Server Solution CD.
The manufacturer’s name and Web address for each application appears in
parentheses at the end of the software description.

Note: The manufacturer of each application supports that application. Contact
information for the manufacturers is provided in the “Productsupport.html”
document in the HTML Pages folder on the CD. Also check the Apple Web
site for AISS (http://www.info.apple.com/AISS) for product news and
information about software updates.

Adobe Acrobat Reader lets you read, print, and search documents that have
been prepared in the Portable Document Format (PDF). Acrobat Reader is
the premier choice for Web documents when maintaining the look and feel of
the document is of particular importance. (Adobe Systems;
http://www.adobe.com)

BBEdit is an HTML editing tool for creating documents in HTML format,
the basic presentation format for the World Wide Web. BBEdit readily
integrates with Internet services (such as Web browsers) to speed the
previewing and composition of Web pages. (Bare Bones Software;
http://www.barebones.com)

Butler SQL is a database query tool that takes your requests for information,
searches the relevant database, and returns the desired data. (EveryWare
Development Corporation; http://www.everyware.com)

Appendix Software on the
Apple Internet Server Solution CD
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Claris Home Page is an excellent tool for people who want to create Web
pages but are unfamiliar with HTML (Hypertext Markup Language). You can
add graphics to pages, design tables, create image maps, and establish or
change links easily with Home Page. The program saves your work as HTML
files that can be used with any Web browser or Web server software. (Claris
Corporation; http://www.claris.com)

FireSite is a Web server accelerator that increases the operating speed of your
server. This program uses the Internet service provider’s equipment as a
graphics cache to allow the rapid flow of information on your Web server.
This version of FireSite also provides “multihoming,” which allows one server
to have numerous domain names. (Clearway Technologies;
http://www.clearway.com)

GoLive CyberStudio provides WYSIWYG editing and sophisticated layout
capabilities for Web pages. This program lets you set up a grid and place
objects within it by dragging. Then the software generates HTML codes to
match your design. Another view of the content shows only HTML codes,
which makes editing simple; still another view shows all the documents and
links in a site. Especially good for sites with multimedia elements. (GoLive
Systems; http://www.golive.com)

LogDoor is a tool for monitoring and logging server access that can detect
and locate broken links, bad links to your site or sites, unreadable pages,
traffic on one or more sites, and a real-time summary of site activity. (Open
Door Networks; http://www.opendoor.com)

MacDNS is a domain name server for the Mac OS. Its function, like that of
all domain name servers, is to map the name of a specific computer on the
Internet to its IP address. (Apple Computer; http://www.apple.com)

MacTCP Watcher monitors TCP operations, supplies a list of TCP
connections, and reports any errors associated with TCP use. MacTCP
Watcher also can trace the path TCP packets follow to a specified destination.
(Peter N. Lewis; http://www.stairways.com)
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NetCloak is a Web server add-on that gives you more than 30 new commands
that you can use in your Web pages. NetCloak provides new commands to
HTML that turn your static Web pages into dynamic ones—pages can change
“on the fly” depending on the criteria you choose. Although these HTML
extensions are nonstandard, they are processed entirely on your Web server,
so they work with any Web browser.  (Maxum Development Corporation;
http://www.maxum.com)

Netscape Navigator is a Web browser. It allows you to view HTML or PDF
documents on your own system or anywhere on the World Wide Web. You
access pages directly by clicking underlined, hypertext links. You can also
access documents on your system by choosing Open File from the File menu
and then using standard Macintosh file techniques to locate and open a file. If
you know the address (the URL) of a page on the Web, you can go to that
page by choosing Open Location from the File menu and typing in the URL.
(Netscape Communications Corporation; http://www.netscape.com)

Page Sentry is a server monitoring tool that uses real HTTP, FTP, SMTP,
DNS, and Telnet client services to test the whole server. If a server fails,
PageSentry alerts you. (Maxum Development Corporation;
http://www.maxum.com)

Rumpus (FTP Server) is software that lets you set up and manage an FTP
(File Transfer Protocol) server on your computer. This type of server is
widely used for uploading and downloading files to a Web site and for
archiving large documents. An FTP server also provides access to Web
content, such as your HTML documents and graphics, from a remote
location. (Maxum Development Corporation; http://www.maxum.com)

Tango Enterprise lets you publish databases on the Web and provides a CGI
(common gateway interface) to process queries from visitors to your site and
deliver the requested data. (EveryWare Development Corporation;
http:/www./everyware.com)

WebSTAR is the heart of your server, the program that lets users access your
pages. Getting started with WebSTAR is extremely easy, but you can also
learn many tricks and techniques to help make your server a better, more
versatile resource. (StarNine Technologies; http://www.starnine.com)
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